
 
How to Use 

Formatting 
Starting to select parts for the actuators 
Hatch Prototype Testing 
Starting to design actuators 
Buckling hatch prototyping 
Backup Recovery Actuation Disk Idea 
Refining Actuator CAD 
Actuator Design Review 
Post-review Actuator changes 
Throwing out the press-fit needed for assembly 
Testing hot-wire cutting a rope 
Rope Hatch Design Work 
Beginning to machine cutter and drums 
Parachute Load and Speed Estimator 
Channel Count for Avionics 
Hatch Decision 
Notes on Manufacturing the Mortar and Hatch 
Progress and General Updates 
Actuators Rev 1 Manufacturing 
Actuators Rev 2 Design 
Actuators Rev 2 Manufacture 
Nichrome Pin Design 
Nichrome Pin Testing 
Nichrome Pin Redesign 

How to Use 
Whenever you do work for Payload/Recovery, write about it here. 
Always add your new writing to the bottom of the document. Don’t add to previous sections, 
and definitely don’t delete anything (but do correct mistakes if you make them). 
Include: 

● Pictures 
● Math (probably scans or Mathematica screenshots) 
● Relevant numbers 
● Data 

Formatting 
Put a page break after the previous project (Insert→Page Break). 
Write the project/experiment name as a “Heading 1” (Format→Paragraph Styles). 
Write the date and your name in bold in the next line. 



You can link to other sections (Insert→Link→Headings). 
You may comment where applicable (Insert→Comment). 
As an example: See the first entry I made here. 
  



Starting to select parts for the actuators 
Jan 28 2016 – Colin Poler 
 
Here’s a preliminary BOM for the actuators: 

Motors Gearmotor 2 

 Motor driver 1 

Drum Aluminum bar 2ft by 0.5in by 3.5in 

 OR Aluminum rod 0.5ft by 3.25inOD 

Box Delrin sheet 0.5in by 12in by 12in 

 Aluminum sheet 3ft by 0.25in by 6in 

 M3 bolts 1 pack 

Shaft Hex shaft 3ft by 0.5” 

 OR Keyed shaft 3ft by 0.5” 

 Setscrews 1 pack 

 Ball bearings qty2, 0.5in ID 

Lines Fishing line, high test 1 spool 

 Surgical tubing 20ft 

Thermal Heatsink 2 

 Thermal adhesive 1 

 
Notes from all-hands: 

● Mass is critical 
○ Use plain bearings instead of ball bearings 
○ Free Alcoa aluminum a possibility, but might be too slow 

● Keyed shaft is recommended by Todd 
○ He has key broaches we can use 

  

https://www.pololu.com/product/2825
https://www.pololu.com/product/708
http://www.mcmaster.com/#8975k621/=10vfk9y
http://www.mcmaster.com/#8974k86/=10vffl6
http://www.mcmaster.com/#8573k18/=10u2b4l
http://www.mcmaster.com/#8975k437/=10vfn3n
http://www.mcmaster.com/#91294a130/=10vfz6o
http://www.mcmaster.com/#6512k181/=10vfctd
http://www.mcmaster.com/#1497k32/=10vflpn
http://www.mcmaster.com/#92313a144/=10tsudf
http://www.mcmaster.com/#60355k601/=10vfvak
http://www.amazon.com/dp/B00QKJQ21G/
http://www.amazon.com/dp/B00563MF68/
http://www.mcmaster.com/#8822t11/=10tsqax
http://www.amazon.com/gp/product/B0087X725S/
https://docs.google.com/spreadsheets/d/1Q-Goxa9rdtZRaFEsxc5exI3tdQyuK73BOVuntjVOJdQ/edit#gid=0


Hatch Prototype Testing 
Jan 29 2016 - Piper Sigrest 
 
 

Test # Observations Lessons Learned 

Sliding Hatch Test 1 
(with zip tie cutter) 

Zip tie cutter worked really 
well, but hatch didn’t slide 
open. 

Pack parachute less tightly in 
the hatch. 

Flipping Hatch Test 1 
(with frangible bolt) 

main chute deployed 
prematurely; frangible bolt did 
not have time to fire. The 
hatch deformed and was 
pulled open by the pilot 
chute. Then the epoxy 
holding the kevlar loop quick 
lined to the main broke. 

Use a zip tie cutter, or at least 
have the retaining device 
through a complete hole in 
the hatch, and not just a 
notch. Epoxy the kevlar loop 
through a hole in the 
bulkhead, not just to the 
bottom of the tube. 

Flipping Hatch Test 2 
(with zip tie cutter) 

Setup and deployment was 
nominal, but when the zip tie 
cutter was fired, the hatch did 
not open because we forgot 
to remove the masking tape 
holding it shut. 

Masking tape is stronger than 
you think. 

Flipping Hatch Test 3 
(with zip tie cutter) 

Removed the tape, then a 
nominal deployment. Test 
stand broke. 

Make test stand sturdier. 

Sliding Hatch Test 2 Unsuccessful; bad e-match. Murphy happens. 

Sliding Hatch Test 3 Very bad; pilot chute pulled 
open the hatch prematurely 
(cardboard on the hatch 
failed by the zip tie). Test 
stand broke again. 

Make test stand sturdier. Line 
the hole in the hatch with 
washers to keep the 
cardboard from failing. 

Sliding Hatch Test 4 zip tie cutter failed add more black powder to zip 
tie cutter. 

Sliding Hatch Test 5 Attempted to use a frangible 
bolt. Bolt did not get kicked 
out of the hole, so the slider 
did not deploy. 

create a reliable break point 
in the frangible bolts. Try 
using a pin on a linear 
actuator instead. 



 
General Lessons Learned: 

- make more solid test stands (to prevent it from spinning in the wind tunnel) 
- make joints very well! 
- frangible bolts need a way to remove themselves (shrapnel or otherwise) 

 
  



Starting to design actuators 
Jan 30 2016 – Colin Poler 
I started to design the actuators in CAD. 
Goals: 

1. Minimize weight 
2. Make manufacturing simple and fast 

 
Manufacturing: mostly waterjetting, a little bit of countersinking, tapping, turning. 
Weight as of now: 0.8029 (1 motor and 1 drum). 
 
  



Buckling hatch prototyping 
Jan 30 2016 – Colin Poler 
Me and Kurtz build a prototype of a buckling hatch. The idea is to support loads during launch 
(mostly compressive), then buckle when the parachute comes out. See below! 

 
We would probably attach the hatch halves to the deployment bag. 
 
  



Backup Recovery Actuation Disk Idea 
Jan 30, 2016 - Piper 
 
Today we (Andrew, Charlie, Colin, and I) started discussing in depth an alternative, 
non-pyrotechnic method for setting up and actuating the backup recovery system. This involves 
two concentric disks with slots in them stacked on one another. The slots, when rotated, trap 
webbing between them. The disks will be actuated via servo. This would be an alternative to 
both the tender descender and the frangible zip tie cutter. After initial discussions, it appears to 
be a good solution because it is fairly light weight, easy to manufacture, easy to integrate, 
imposes more than tolerable loads on the system (including servo), and is generally pretty 
elegant. Charlie is going to start building and testing a Mark I prototype of the system. We are 
also considering using this to actuate the hatch, but we are focusing more on the backup 
recovery system because the flipping hatch technique is already fairly promising. 
 

 
  



Refining Actuator CAD 
Jan 31, 2016 - Colin 
I redesigned the actuator to be lighter, and figured out how to mount it to the rocket. 
New weight: 0.77lbs each! 

 

 
  



Actuator Design Review 
Feb 1, 2016 - Colin 
Revised BOM: 

Motors Gearmotor 2 

 Motor driver 1 

Drum Aluminum bar 2ft by 7/16in by 3.5in 

Box Delrin sheet 0.5in by 12in by 12in 

 Aluminum sheet 3ft by 1/8in by 6in 

 M3 bolts 1 pack 

 6-32 1in Bolts 1 pack 

Lines Fishing line, high test 1 spool 

 Surgical tubing 20ft 

Thermal Heatsink 2 

 Thermal adhesive 1 

Bulkheads Fiberglass cloth  

 1/4in balsa wood  

 Epoxy  

 Grommets 1 pack 

 6-32 .75in Bolts 1 pack 

Weight as of now (whole system): 930.73g 

https://www.pololu.com/product/2825
https://www.pololu.com/product/708
http://www.mcmaster.com/#8975k621/=10vfk9y
http://www.mcmaster.com/#8573k18/=10u2b4l
http://www.mcmaster.com/#8975k437/=10vfn3n
http://www.mcmaster.com/#91294a130/=10vfz6o
http://www.mcmaster.com/#91792a153/=10xvcdt
http://www.amazon.com/dp/B00QKJQ21G/
http://www.amazon.com/dp/B00563MF68/
http://www.mcmaster.com/#8822t11/=10tsqax
http://www.amazon.com/gp/product/B0087X725S/
http://www.mcmaster.com/#5269t12/=10xupnz
http://www.mcmaster.com/#91785a151/=10xuhrh


 
Notes from review 

● Change holes to close fit so no sliding 
● Flathead motor screws instead of hex 
● Brass bearings 
● Pressfit tolerances? 
● Carbon fiber to fiberglass 
● Flat faces on delrin circle 

  

http://www.mcmaster.com/#standard-sleeve-bearings/=10xvtq0


Post-review Actuator changes 
Feb 1, 2016 - Colin 
Post-review BOM: 

Motors Gearmotor 2 

 Motor driver 1 

Drum Aluminum bar 2ft by 7/16in by 3.5in 

Box Delrin sheet 0.5in by 12in by 12in 

 Aluminum sheet 3ft by 1/8in by 6in 

 M3 bolts 1 pack 

 6-32 1in Bolts 1 pack 

 Brass bearings 2 

Lines Fishing line, high test 1 spool 

 Surgical tubing 20ft 

Thermal Heatsink 2 

 Thermal adhesive 1 

Bulkheads Fiberglass cloth  

 1/4in balsa wood  

 Epoxy  

 Grommets 1 pack 

 6-32 .75in Bolts 1 pack 

Weight as of now (whole system): 930.73g 
 
  

https://www.pololu.com/product/2825
https://www.pololu.com/product/708
http://www.mcmaster.com/#8975k621/=10vfk9y
http://www.mcmaster.com/#8573k18/=10u2b4l
http://www.mcmaster.com/#8975k437/=10vfn3n
http://www.mcmaster.com/#91430a114/=10xwrgx
http://www.mcmaster.com/#91792a153/=10xvcdt
http://www.mcmaster.com/#5448t1/=10xwgmf
http://www.amazon.com/dp/B00QKJQ21G/
http://www.amazon.com/dp/B00563MF68/
http://www.mcmaster.com/#8822t11/=10tsqax
http://www.amazon.com/gp/product/B0087X725S/
http://www.mcmaster.com/#5269t12/=10xupnz
http://www.mcmaster.com/#91785a151/=10xuhrh


Throwing out the press-fit needed for assembly 
Feb 2, 2016 - Colin 
I realized a press-fit drum would be unreliable (chinese motors don’t have tight tolerances on 
the shaft) and hard to install. My bad. So I’m going to use a 4-40 t-slot set screw (sketch below, 
will CAD ASAP). 
 
New parts: 

Drum Aluminum sheet 7/16in by 8in by 8in 

 4-40 square nuts 1 pack 

Box Aluminum sheet 1ft by 1/8in by 4in 

Bulkheads 1/4in balsa wood  

 
  

http://www.mcmaster.com/#9246k486/=10yigu6
http://www.mcmaster.com/#94855a281/=10yi5rc
http://www.mcmaster.com/#8975k418/=10yig09
http://www.mcmaster.com/#5068k53/=10yi2hg


Testing hot-wire cutting a rope 
Feb 2, 2016 - Colin 
I tested cutting a rope with a hot wire. 

● Wire and rope held perpendicular, both under tension and pressed against each other 
○ The tension was roughly 50N and cross-pressing force roughly 5N 

 

 
The ropes tended to break in a distinct triangle pattern. 
The current required was about 2.3 amps (3.4 volts) for about 10 seconds before it broke. 
 
I tried it 10 times, and it worked 9 times. During the failure, the wire melted to itself. But I may 
not have applied enough tension. 
Overall, probably not the best way to cut, unless the ropes are very thin. 
 
 
 



--new entry to format. 
Hatch Meeting 
Feb 2,2016 - Piper 
 
Last n 
 
 
 
  



Rope Hatch Design Work 
Feb 3, 2016 - Andrew 
 
 

 
need to figure out manufacturing, not sure we will be able to make the slot that the knife slides 
along. Also need to do research on how tight the tolerance needs to be between the knife, pretty 
much concerned about the gas escaping around the knife. need to figure out a way to quantify 
that shit as well as determine what the cutting force is going to be. Thinking it might be fun to 
just test that shit.  
The large piece on the end of the chamber opposite to the knife is HDPE and is there to try and 
catch the blade after it has cut the knife.  
 

 
 



 
  



Beginning to machine cutter and drums 
Feb 5, 2016 - Colin 
We machined a blade into the zip tie cutter, then hardened it using the blowtorch and a bucket 
of water: 

 
We machined a jig for making the drums for actuators: 

 
Everything is in a clear box on the recovery shelves. 
 
 
 
 



Parachute Load and Speed Estimator 
Feb 7, 2016 - Piper 
 
I made a MATLAB script to estimate the loads and speeds of parachutes when they deploy. 
Found on the Dropbox here: 
https://www.dropbox.com/work/Rocket%20Team/IREC%202015-2016/Recovery 
 
 
 
  

https://www.dropbox.com/work/Rocket%20Team/IREC%202015-2016/Recovery


Channel Count for Avionics 
Feb 7, 2016 - Piper, Colin, Andrew K, Andrew A, Martina, Ricardo, Jake 
 
Channels needed to deploy things: 
 
Parafoil System: 
Mortar - x2 pyro (for redundancy) 
3 options for parafoils: (chose one of the following) 

Break Away Hatch - x1 pyro 
Flipping Hatch - x1 pyro 
Servo Hatch - x2 (1 pyro, 1 servo) 

 
Cutting Away the Parafoil: 
x1 pyro 
 
Backup System: 
deploy nose cone/drogue - x2 pyro (for redundancy) 
deploy main - x1 (pyro or servo) 
 
Total: 
7 pyro channels, up to 2 servo channels 
 

  



Hatch Decision 
Feb 11, 2016- Piper, Andrew Kurtz, Colin, Andrew Adams, Eric, and Co.  
 
At the last team leads meeting, we decided between the pyro flipping hatch, servo flipping 
hatch, and rope cutter hatch to pursue the rope cutter hatch. This was largely for the following 
reasons: 
 

● Light weight 
● Simple design/few “moving” parts 
● Easy integration 
● Easy manufacturability 
● The hatch is retained with the deployment bag, but goes away from the hatch to reduce 

the risk of snagging on the parafoil 
● We already have a working prototype/design of the rope cutter to test 

 
A summary of pros and cons can be seen in this picture: 

 
 



 
  



Notes on Manufacturing the Mortar and Hatch 
Feb 16, 2016 - Piper S. and Andrew A. 
 
This past week, we’ve been working on manufacturing the hatch and mortar for the first drop 
test. A quick procedure write-up: 
 

1) Cut the ends of the 3” mortar tube at 45 deg angle using the (soon-to-be-existing) jig.  
2) trace out on the body tube where the couplers will go (about 5” from each end) 
3) trace out where the mortar will go (give it about 12” of space, at the top of the hatch tube, 

closer to the nose cone). Trace one end of the cut mortar tube to get the size and shape 
about right. 

4) trace out where the hatch will go. Should be directly beneath the mortar (give an inch or 
so of margin space). 18” long, and ⅓ the circumference of the tube. 

5) Cut out the hatch with the Fein Multimaster. Pretty straight forward. 
6) Cut out the hole for the mortar in the main body tube. To cut out the hole for the mortar 

in the tube, I recommend using the Dremmel. lightly score the top surface of the tube, to 
just cut through the fiber glass layer. This lets you make really nice smooth curves. 
Then, cut through the rest of the phenolic with a hand held razor. It takes a bit of effort 
but gives you a nice curve. 

7) Sand things with the dremmel. make them pretty. If you can, make the ends of the 
mortar tube more concave so that they fit more flush with the main body tube. 

 
NOTE: We need to find a nice way to round out the corners of the hatch. According to some 
structural analysis by a friend of Will’s, that’s the first failure point. I think we can try doing this 
using the partial-scoring method with the Dremmel. Rounding the corners will also help mitigate 
the risk of the parafoil snagging when it deploys. 
 
NOTE: Kurtz literally just suggested drilling a hole in each sharp corner with a hand held drill bit. 
Like this: 
 

 



 
To be completed: 
8) machine the little aluminum pieces that go on each end of the hatch 
9) machine the rope cutter (one for the hatch section and one for the backup recovery section 
10) cut the rope to the appropriate length. 
11) integrate everything. 
 
 
 
  



Progress and General Updates 
Feb 20, 2016 - Piper 
 
Today we made good progress on recovery. A mount for the mortar is currently being 3D 
printed, and a seal for the mortar will also soon be printed. Andrew is working on a calculator for 
ejection charge sizing. We cut supports for the hatch out of thin plywood. See calculations for 
the dimensions below. We also decided to try the Tender Descender for the backup recovery 
system. I sketched out some alternative ideas, but I think (from consulting with Andrew and 
Zach) that the Tender Descender is worth a shot, because it’s designed for exactly this scenario 
and we will actually be able to access it to integrate it this year. If, during CRIMP, we see that it 
is not an effective solution, we can switch to an alternative method. But for now, the Tender 
Descender is nice because it’s a proven system, basically all ready to go. 
 
Hatch Dimension Calculations: 

 
 
Alternative Backup Recovery System Ideas: 



  



Actuators Rev 1 Manufacturing 
Early March, 2016 - Colin 
 

● Machining the delrin housings was very annoying. The delrin would deform under the 
clamp, and would then slip during cutting. I had to use the Hobby Shop’s sander to fix 
the interior. 

● Machining the drum was also very annoying. We had to use a cutoff tool to cut the 
groove, which Todd didn’t like. And then centering the hole at the top was also hard 
(also, I messed it up). 

● The bushings were metric, which made them very difficult to hold in the lathe. They need 
to be imperial next time. 

● Everything else was relatively straightforward to machine. 
● Assembling it was annoying at points, but not too bad. 
● Inserting them into the rocket was difficult, because they’re so big. I’m going to make the 

next revision much smaller.  



Actuators Rev 2 Design 
Late March, 2016 - Colin 
 
I designed new actuators! 

 

 



To make manufacturing easier: 
● Imperial bushings (we need to drill out the center to 6mm) 
● Flat drum (increases usable area for line, and easier to make) 
● Smaller package 

○ Uses a faster motor and smaller drum 
● Adjustable spacing from bulkhead 
● Smaller and simpler delrin housing (easier to make)  



Actuators Rev 2 Manufacture 
Early April, 2016 - Colin 
 

● I made a custom fixture for the delrin blocks. This made them super easy to make, and 
super nice. 

● Bending the plates broke one of them. Never flange a plate that needs to be bent, 
lubricate the parts and just don’t bend things with Todd’s brake press. It’s terrible. 

● Glue in the nuts before inserting them in the rocket, because they’re hard to reach. 
● Threadlock the bolts that hold the housing together, because if they’re too tight they stall 

the motor, and if they’re not tightened, they come loose.  



Nichrome Pin Design 
May 1, 2016 - Colin 
 

This is my first design for the nichrome pin release mechanism: 
 

 



The spring exerts 26lbs of force. The minimum gauge of wire that will support this is 22AWG 
nichrome wire. So, for safety, use 18AWG wire. 
Grease needs to be applied to the pin for every use. 
The pin and sleeve are to be manufactured from steel rod. 
A thread is tied through the pin as a retention device, so it doesn’t go elsewhere. 
The leads from the capacitor are soldered onto the bent pieces. 
The U bolt needs to be epoxied into the bulkhead, and requires some manual fitting (not just 
straight drilled holes, unfortunately) 
The design just barely fits next to the actuators. Unfortunately, the actuators will need to be 
removed in order to reload the pin release mechanism. 
Find the CAD files here. 

 

http://www.mcmaster.com/#9657k305/=1283gen
http://www.mcmaster.com/#8927k96/=128j898
http://www.mcmaster.com/#3043t613/=128jbkk
https://drive.google.com/file/d/0B0DZsAM02zeCRkMxMXA1Wk1RT1E/view?usp=sharing


 
  



Nichrome Pin Testing 
May 10, 2016 - Colin 
 
I had to make some change to the design. The barrel now has a 0.5” OD, and I only drilled the 
spring hole down to 3/16”. Also, the inner hole was drilled out to 17/64. I lubricated the pin with 
Todd’s blue grease. 
 
Anyway, I started with 22AWG nichrome wire. I put Kapton on the steel pin, then clamped the 
wire on one end, used a vice to compress the spring, then clamped the other end. Then I 
plugged it into the power supply, and it gave 10A with 2V. The wire didn’t break though. 
 
Then I tried 36AWG nichrome wire. This broke before I even clamped it on both ends, so I 
deemed it too fragile. 
 
Then I borrowed Dave’s 26AWG nichrome wire. This quickly broke under 10A, which led to the 
pin rather violently being ejected. 
 
Then I borrowed Dave’s 26AWG steel wire. This also broke, maybe a little slower, under 10A, 
which led to the pin being violently ejected again. I tested it one more time to watch the voltage, 
but I couldn’t see anything when it broke so quickly. So I measured the resistance, and it was 
about 1R. 
 
Charlie has posted the videos here: 
https://www.dropbox.com/sh/6zu1792qyg3uf1q/AABDkK4EUYYiZXQCJDWJP-BCa?dl=0 
 
  

https://www.dropbox.com/sh/6zu1792qyg3uf1q/AABDkK4EUYYiZXQCJDWJP-BCa?dl=0


Nichrome Pin Redesign 
May 11, 2016 - Colin 
 
I made some changes to the nichrome pin release mechanism. 

● The original tabs were stainless steel, which can’t be soldered to. Instead, we’ll use 
brass. 

● A pin retention method needed to be built, so this will use fishing line (which is weaker 
but  has a higher fracture energy than metal) 

● I got rid of the U-bolt in favor of a machined wall, made of delrin. 
● I made almost all of it insertable from the hatch side, so make integration easier. 
● The spring pushes directly on the steel barrel, which makes me feel better 

Problems: 
● Need square hole in bulkhead 
● Fun times machining ;-) but it’s delrin, so it’ll be fine, probs. 

 



 


